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Mac Basics Workshop @  

The Southeast Steuben County Library:  
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Apple Menu: 

If you click the Apple icon located in the top left hand corner of your screen you’ll gain access to a number of helpful options! 

Access this menu will allow you to find out which software version your Mac is running (About This Mac), see if there is a 

software update for your Mac and then install it (Software Update), quickly access the Mac App Store (App Store), change 

your System Preferences (System Preferences…), change where you Dock displays (the dock is what Apple calls the row of 

icons that by default is located at the bottom of the screen ), see what recent items you have opened (Recent Items) Force 

Quit an unresponsive program (Force Quit), put your Mac to sleep (Sleep), Restart your Mac (Restart…), Turn off your Mac 

(Shut Down…) or log out of you Mac (Log Out and then your user name) 
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File Menu 

Accessing the File Menu will allow you to create a new folder and burn most documents or files you have open to disc among 

other options. What you can do with this menu varies a bit depending upon what software or document you have open at the 

time.  
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The Finder Menu 

Opening the Finder Menu will allow you to do a number of things including change the picture on your desktop and open a 

new email and insert an attachment.  
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Go Menu: 

The Go Menu is aptly named as it will allow you to quickly access the main parts of your Mac — the Go Menu is Apple’s ver-

sion of what on Windows Computer would be the My Computer Folder for Windows XP, Vista & 7 Users and the Windows 

Explorer folder for Windows 8 users. In short the Go Menu allows you to quickly access your Documents Folder and any flash 

drives, digital cameras or other tech devices that are plugged into your Mac. 
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The Help Menu 

If you have a question about how to use your Mac you can access the Help Menu which will bring up a search box and allow 

you to search the Help subjects on your Mac to find an answer. 

 

Note: You can also do a Google search! Just access the Internet via the Safari icon and go to Google, at google.com and type 

in your question. For example you might Google “How do I Turn off a Mac” or “Where can I find my flash drive Mac?” 
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Spotlight Search 

The Spotlight Search will allow you to search your Mac for folders, documents, emails, photos etc. 

For example, say you have 1,000 email messages in your inbox and can’t find the one your sister sent you that includes a 

great Cranberry Muffin recipe — you can click on the spyglass to access the Spotlight search and then type in “Cranberry 

Muffins” and your Mac will search all the files on your computer for those words and bring up the email that includes that 

recipe — so you don’t have to search through 1,000 emails to find it! 
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The Dock 

The Dock is what Apple calls the row of icons located at the bottom of the desktop. 

You can modify your Dock and add or remove icons to your Dock, have the icons wave out at you or make them stay still or 

even move the Dock and all the icons to the left or right side of your screen if you wish.  
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The Finder  

Clicking on the Finder icon is similar to clicking on Go Menu as it allows you to view the other places on your Mac that you 

might save files, documents photos or media.  

The Finder icon is seen bordered in red in the example below. 
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Dashboard 

Opening the Mac Dashboard will allow you to access, and add, remove or customize the widgets on your Mac. 

And if you’re wondering “What on Earth is a widget?” The basic answer is it is a piece of software that performs a specific 

function or service. 

For example, accessing a function widgets seen below include the clock, calendar, calculator or post it note because those 

items are self-contained. In contrast the ESP widget seen in the middle of the screen is a service widget because it requires 

information be sent to your Mac from ESPN. 

The Dashboard icon is seen bordered in red in the example. 
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Mail 

You can set up your email so you can read it via the Mail icon on your Mac. 

Seen below is an example of an opened Mac Inbox. 

The Mail icon is seen bordered in red in the example. 

 



 12 

Safari  

Safari is Apple’s web browser.  

In other words it is a portal to the Internet, as long as your Mac is receiving a Wi-Fi signal , clicking on the Safari icon will 

bring up the Internet just as Microsoft’s Internet Explorer would if you were using a Windows PC. 

The Safari icon is seen bordered in red in the example.  
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The Mac App Store 

Newer versions of the Mac operating system software (or OS) support the Mac App Store.  

Think of the Mac App Store as being kindred spirit to the App Store on an iPad or iPhone because like the App Store you can 

access from an iPhone or iPad  you can download games, educational apps, office/business related apps and even apps that 

allow you to easily download e-books to your Mac like the Kindle app. 

The Mac App Store icon is seen bordered in red in the example.  
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iChat 

iChat is Apple’s Video old Conference Software  (aka Video Call) software. 

iChat has been replaced by Facetime for iPod, iPhones and iPads and newer Macs. 

Also of note, iChat and its successor Facetime can only be used to make video calls between people who are both using Apple 

devices — this software will not work on a Windows computer. So if you wish to make video calls to anyone using any 

Internet connecting device you should download the Skype version for Mac found on the Skype website.  
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 Address Book 

Seen below is the opened Address Book software. 

You can use this software as a replacement for a traditional paper calendar and can even change your settings to link your            

Address Book contacts between Apple devices so if you have an iPad, an iPhone and an MacBook Pro and you add a new 

contact on one of those devices that contact will then show up on all three devices.  

The Address Book icon is seen bordered in red in the example. 
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iCalendar 

iCalendar, which is simply called Calendar on newer Apple devices, allows you to replace an traditional paper day planner with 

this electronic planner. And if you own several Apple devices for example an iPhone, iPad and MacBook or any combination 

thereof you can change your settings so that if you add a new event to your Calendar it will automatically be pushed to all 

your Apple devices . 

Note: If you’re using an iPad or iPhone the iCalendar app is simply called Calendar.  

The iCalendar icon is seen bordered in red in the example.  
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iTunes 

If you want to download music, movies or television shows to you computer or access music, movies or television shows 

you’ve previously purchased from iTunes for another device — than iTunes is the software for you! 

You can buy music, movies, audiobooks and television shows from iTunes and watch them on your MacBook and later access 

them from your other Apple devices through the iTunes icon which is also known as an app if you’re using a mobile Apple 

computing device like the iPhone, iPad or iPod Touch. 
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Photo Booth 

 

Photo Booth, which is also a pre-installed app on iPhones, iPod Touches and iPads, allows you to take photos and then add 

effects. 

Example one seen at left shows a typical photo with no effects and example 2 on the right shows another photo to which 

thermal effects have been added.  

 

The Photo Booth icon is seen bordered in red in both examples. 
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iPhoto  

The iPhoto software allows you to organize any photos you have on your Mac and even to, when your Mac is connected to the 

Internet, mark the actual geographic locations where the photos were taken. 

This particular MacBook Pro didn’t have any photos on it which is why there isn’t a banner of photos displaying in the dark 

iPhoto box. 

The iPhoto icon is seen bordered in red in the example on the left. The example on the right shows what iPhoto 11, the new-

est version of iPhoto looks like when the software is opened.   
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iMovie 

If you’d like to create your own videos Apple has a solution! The iMovie software comes with every Mac and allows you to cre-

ate and customize your own videos. 

The example shows a blank iMovie page before any videos have been imported. 

The iMovie icon is seen bordered in red the example.  
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Garage Band 

If you’re a musician or songwriter or would like to be — Garage Band is the software for you! 

You can use this software to record separate guitar, bass, drums and keyboard tracks and then mix them together. 

You can also choose different types of instruments with categories for example the guitar category features an acoustic guitar 

and electric guitar the keyboard category features a piano and an organ and you can even, if you purchase an adapter plug 

your real world guitar or microphone into your Mac and record live music from the real world. 

The Garage Band icon is seen bordered in red in the example.  
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System Preferences  

Opening the System Preferences folder on a Mac is like opening the Control Panel on a PC as it allows  you to change the 

settings on your Mac. So for example if you prefer a mouse set up that allows you to both right and left click you can open the 

Mouse settings and make that change (the default on a Mac is for the mouse to left click only).  

You can also change the Appearance of your Mac software as it displays (the size and style of the icons etc.), the desktop             

photo and the Screen Saver via the System Preferences folder. 

Also of Note, the default for icons in the dock is to have them wave out at you in what Apple calls “Magnification” mode — if 

you don’t like that feature you can disable it by open the Dock settings. 

The System Preferences icon is seen bordered in red in the example.  
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Pages & Numbers 

Pages is Apple’s version of a cross between Microsoft Word and Microsoft Publisher and you can type letters,                                    

create brochures, flyers, banners or other documents using this software. 

Numbers is Apples version of Excel — in essence it is a sophisticated spreadsheet software. 

Pages & Numbers do not come with a new Mac but can be purchased for $9.99 each from the Mac App Store.  

The example on the left shows the opened Pages software with some of the included templates displayed and the example on 

the right shows the Numbers software opened and with several usable spreadsheet templates displayed. 

The Pages icon is seen bordered in red in both examples and the Numbers software is seen bordered in blue.  
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Applications, Documents and Downloads Folders 

The last three folders on the end of the dock row — located at the very right just to the left of the Trash are the Applications, 

Documents and Downloads folders. 

Clicking on the Applications icon will show you a list of the applications on your Mac. 

Clicking on the Documents icon will show you a list of documents recently opened on your Mac 

And clicking on the Downloads folder will show you a list of the recent items you have downloaded in case  you need to 

quickly access them again. 

In the photo below the Applications folder is seen first the Documents folder is seen in the middle and the Downloads folder 

is seen on the very right next to the Trash icon. 
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Thanks for checking out the handout for our  

Check out our website for a listing of upcoming library programs. 

And if you ever need assistance in learning how to use a new iPad, PC, Mac, e-reader etc. you can always call 

us and make an appointment for a free One-On-One session with a member of our Digital Literacy Services  

team:  

Linda or Jenn. 

Call us at 607-936-3713 

 

Check out the library website at: SSCLIBRARY.ORG 

 

And our Tech Talk blog located at: sscltech.wordpress.com 

 

You can also find both a Southeast Steuben County Library and SSCL Digital Literacy Services page on  

Facebook. 

 

 

 


